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Preface

The Solstice Backup User’s Guide contains instructions on how to use Solstice™
Backup backup, archive, and recover software from a client workstation.  The
User’s Guide shows how to back up files and directories to the Backup server
on an as-needed basis using the Backup window.  It also shows how to browse
the online file index to recover files using the Recover window.  Instructions
for using the optional Solstice Backup Archive Application are also included in
this guide.

For information on server configuration and administration, refer to the Solstice
Backup 4.2 Administration Guide.

Note – In this document, the terms Solstice Backup, Backup, and NetWorker
refer to the same product.

Audience
Those who will benefit most from this manual are users and system
administrators who use Backup to back up, recover, archive, and retrieve data
from a client workstation.
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Customer Support
SunSoft and SMCC support programs are designed to meet customers’
complete system needs. The programs support a wide range of needs.

For detailed information about our services, support policies, and software
subscriptions, contact your local customer support office for programs and
their availability.

What Typographic Changes Mean
The following table describes the typographic changes used in this book.

Table 0-1

Typeface or
Symbol Meaning Example

AaBbCc123 The names of commands,
files, and directories;
on-screen computer output

Edit your .login  file.
Use ls -a  to list all files.
machine_name% You have mail.

AaBbCc123 What you type, contrasted
with on-screen computer
output

machine_name% su
Password:

AaBbCc123 Command-line placeholder:
replace with a real name or
value

To delete a file, type rm filename.

AaBbCc123 Book titles, new words or
terms, or words to be
emphasized

Read Chapter 6 in Solstice Backup 4.2
User Guide. These are called class
options. You must be root to do this.
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Shell Prompts in Command Examples
The following table shows the default system prompt and superuser prompt
for the C shell, Bourne shell, and Korn shell.

Table 0-2

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell
prompt

$

Bourne shell and Korn shell
superuser prompt

#
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Introduction 1

Solstice Backup is an easy-to-use network storage management software
product.  Backup performs automatic backups of your files, scheduled by your
system administrator, to protect against the loss of valuable data.  You can also
perform backups on an as-needed basis and archive project-related data for
additional protection.

With Backup, file recovery is fast and convenient, so you do not waste time re-
creating lost files.  Simply scroll through Backup’s list of backed-up files and
recover the files to your disk.  Backup even shows multiple versions of a file,
backed up over time, allowing you to select the version you want to recover.
Backup provides access to these powerful features through an intuitive
graphical user interface (GUI).

The optional Solstice Backup Archive Application provides the ability to take a
snapshot of finished project files or directories residing on primary media
(usually disk).  You can choose to have archived files automatically removed
from disk, after Backup verifies the snapshot is safely stored on removable
media, to conserve disk space.

Unlike backed-up data, the media used for storing archived data is never
recycled.  Archived data is preserved for as long as you need it.  Archiving
data associated with a finished project frees up space for current projects, while
assuring future access to mission-critical data.

To use the Archive Application, your system administrator simply enables the
software on the Backup server and clicks a choice to revise your client setup.
No additional installation procedures are required.
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Overview
The Backup server is a machine with a backup device that automatically backs up
all the systems on a network.  Once your system administrator installs Backup
and configures the server to recognize your system as a Backup client:

• automatically backs up your files on a routine, scheduled basis
• backs up selected files at any time on an as-needed basis
• provides long-term storage of project data with the optional Archive

Application

When you use Backup to back up your files, the files are saved to backup
volumes on the Backup backup device.  The Backup server keeps an online
index of the backed-up files.  You browse this online index to recover a single
file or a complete directory.

Archiving involves long-term storage of data on media called archive volumes.
Archive volumes are similar to backup volumes, but are stored for very long
periods of time and are not automatically recycled.
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About this Guide
The Solstice Backup 4.2 User’s Guide contains information on backing up and
recovering data using the Backup and Recover windows.  Instructions for
using the Archive and Retrieve windows available through the Archive
Application are also included.

This guide is organized into sections to help you locate the kind of information
you need, including shortcuts, examples, and step procedures.

Using the Backup Programs
After the Backup server is set up, your system administrator will install two
programs: nwbackup  and nwrecover .  The system administrator will install
the software on your system or configure your system to access Backup
remotely.

If the optional Archive Application is enabled for your site, two additional
programs are available for use: nwarchive  and nwretrieve .  The system
administrator changes your client configuration to allow your system to use
the Archive Application.
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Getting Started 2

This chapter describes how to start the Backup programs and navigate their
windows.  It provides a Quick Tour using Backup for Solaris to back up and
recover files from a client system.  To use Backup, your system must be
configured as a Backup client.

Note –  Also, you need to add the path /usr/bin/nsr  to your PATH
environment variable in order to use the Backup executables.

See Appendix C, “Requirements for Backup Clients,” for details on the
requirements for Backup clients.

If your site has the optional Backup Archive Application, be sure to read
Chapter 5, “Archiving and Retrieving Files,” for information on using the
program windows.

When Backup is running on your system, you see the Backup icons or the
Backup and Recover windows on your screen.  The program icons include the
“Backup knight” and the program caption.  Click the icon to open the program
window.

If you do not see the Backup icons or the Backup windows on your screen,
start Backup from a command line on your system.
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Starting Backup
To start Backup from a command line, enter the nwbackup and nwrecover
commands, followed by the server name, and an ampersand (&) to run Backup
in the background:

If you have a multi-server network and do not specify a server name, Backup
chooses a backup server for you.

Note – You can start Backup from any directory.  The directory Backup starts
from will be the directory shown in the Backup or Recover directory display.

If you receive an error message while starting Backup, there may be problems
with your network configuration.  Refer to Appendix C, “Requirements for
Backup Clients,” to confirm that your system is configured correctly as a
Backup client.  If you need further help, contact your system administrator.

Backup uses windows, pull-down menus, and dialog boxes to guide you in
backing up and recovering files.

Using Backup Windows
Backup displays your files and directories using icons and windows.  Backup
windows provide an easy-to-use X Window System graphical user interface
(GUI).  This section shows you how to use Backup windows.

# nwbackup -s server_name  &

# nwrecover -s server_name  &
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Window Components

The following graphic shows the Backup window and its components.

Menu Bar

The menu bars in the Backup and Recover windows contain the File, Tree,
View, Change, Mark, Options, and Help pull-down menus.

There are two choices for navigating Backup menus.  You can use the point and
drag method with a mouse, or you can use the keyboard shortcuts.

Mount point icon

File icon

Highlighted directory

Menu bar

Speed bar

Selection
panel

Directory display

File display

Directory icon
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• To pull down a menu using a mouse, move the mouse so its arrow points to
your menu choice.  Hold down the primary mouse button (usually on the
left); the menu appears.  With the mouse button still held down, drag the
mouse arrow to the command in the menu, then release the button to make
your choice.

• To pull down a menu using keyboard shortcuts:

1. Hold down the [◆] key or the [Alt] key.

2. Press the key that matches the underlined letter of the menu name.

3. Release both keys, then press the key that matches the underlined letter
in the command name.

Note – The left and right mouse button actions used in this manual are X
Window System defaults.  If you have problems using the mouse, your mouse
buttons may be programmed differently.  See your system administrator for
help.

Online Help

Select the online Help menu, available in any Backup main window, for help
on using Backup.  Online help is available for components of the selected
window, menu items, and dialog boxes.

The Help pull-down menu provides commands that provide help on the
current window, a list of help topics to browse, directions for using Help, and
information about the version of Backup you are using.

Select the On Topic command in the Help pull-down menu to open the Topics
Help dialog box, as shown.
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To see more information about a topic, click its title in the Topics scrolling list.
Help text for the selected topic appears at the top of the dialog box.  The Topics
scrolling list remains available in the bottom panel for selecting other topics.
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For example, clicking the topic Backup produces the following dialog box.

To return to the Backup window, click the Cancel button.

Speedbar

The five graphical buttons that appear on the speedbar serve as shortcuts for
the following commands:

• Change Server – switches to a different Backup server
• Mark – marks directories or files
• Unmark – unmarks directories or files
• Search – searches for specific directories or files
• Start – starts the backup or recover operation
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The speedbar is identical in the Backup, Recover, and Archive windows.
Clicking a speedbar button produces the same result as selecting the command
from a pull-down menu.

Selection Panel

The selection panels in the Backup, Recover, and Archive windows show the
current server and client selected.  The selection panel in the Recover window
also displays the current Browse Time.

The Selection field shows the full pathname of the currently-selected file or
directory.  Enter text in the Selection field or click a directory or file icon to
select a different pathname.

Directory and File Display Areas

The window is divided into two display areas:  a directory display on the left
side and a file display on the right side.  Both display areas contain vertical
and horizontal scrollbars that allow you to view complete directory and file
information. You can adjust the window to fit more information in the display
areas.  The display areas contain icons that represent the files and directories in
the path you select.

Window Controls

Navigate vertically or horizontally in the directory and file displays by clicking
the scrollbar or triangular endpoints, or by dragging the slider.Scroll

bar

Slider
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Icons

Use the check box next to an icon to mark and unmark files and directories for
backup or recover.  The icons you see in the window are described below.
(Some of the icons represent terms common to UNIX.)

Folder icons represent directories.

Open folder icons indicate that the tree structure of the directory, if any exists,
appears in the directory display.

A check mark in the check box next to a folder icon for a subdirectory indicates
that it is marked for backup or recover.

Shaded folder icons indicate a directory selected for menu actions.  The folder
contents appear in the file display.

Folder icons with this symbol represent mount points.

Sheet icons represent files.

Shaded sheet icons indicate files selected for menu actions.

Chain icons represent symbolic links.

Brick icons represent block devices.

Icons with this symbol represent character devices.

Clock icons replace the cursor when Backup is performing a task.
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Exiting from a Window

The Exit command is in the File menu of all Backup windows.  Selecting the
Exit command closes the current window, without backing up or recovering
files, and quits the current program.

Quick Tour
Follow the instructions in this section to become familiar with how Backup
functions.  The “Quick Tour” shows how to back up your current directory and
recover a file using Backup. Chapter 3 and Chapter 4 provide detailed
information about using Backup. Chapter 5 provides detailed information
about using the optional Backup Archive Application.

Backing up Your Directory

The Backup window displays a graphical representation of the path with the
current directory highlighted.  The Backup window lets you browse the
filesystem to examine your directories and decide which files to mark for
backup.

The Quick Tour takes you through the following steps to practice backing up a
file:

• opening the Backup window
• expanding the current directory
• marking an entire subdirectory for backup
• excluding a file from the backup
• starting the backup
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Opening the Backup Window

Select the Backup icon to open the Backup window.  The Backup window
appears, as shown.

The Selection field displays the pathname of the directory where you originally
started Backup.  The directory display shows a graphical representation of the
path with the current directory highlighted.  A highlighted directory is
represented as a shaded folder icon in the display.  The file display shows the
contents of the current directory.  A highlighted file is displayed as a shaded
sheet icon.



Getting Started 15

2

Expanding the Current Directory

Expand the current directory one level to find a subdirectory to mark for
backup.  Select Expand One Level from the Tree menu.

The directory display changes to show the expanded directory, one level below,
as shown.

Marking a Subdirectory

To mark a subdirectory, click the check box next to the folder representing the
subdirectory you want to back up.  A check mark (✓) appears in the check box,
as shown.



16 Solstice Backup 4.2 User’s Guide—April 1996

2

Click the folder to display its files.  In the file display, the files and
subdirectories contained in the marked subdirectory also appear marked, as
shown.

When you mark a directory, its nested files and subdirectories are marked as
well.  The check boxes of the parent directories are shaded to indicate that a
subdirectory has been marked.

Note – You can also mark a directory by clicking its folder in the directory
display and clicking the Mark speedbar button. The effect is the same as
clicking the check box next to its folder.
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Excluding a File from the Backup

You can exclude a file from the backup by unmarking it.  Click the check box
next to a file to unmark it in the file display.  The check mark disappears,
excluding the file from the backup.

Note – You can also unmark a file by clicking its folder in the file display and
clicking the Unmark speedbar button. The effect is the same as clicking the
check box next to its folder.

Starting the Backup

After you finish marking files, you are ready to start the backup.  Click the
Start speedbar button to start the backup.
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Before the backup starts, the Backup Options dialog box appears.

Note – You can exclude groups of files by entering UNIX shell pattern
matching characters in the Backup Options dialog box.  For information on
excluding patterns, see Chapter 4, “Backing up and Recovering Files.”

Use the Backup Options dialog box to tell Backup whether or not to compress
the files during backup.  The default choice for Do you want to compress this
backup? is already highlighted, as shown.  Click the Ok button to continue the
backup with file compression.

Note –  Compressing your data during backup saves space on the backup
media and reduces network traffic, but may slow down the backup operation.
Check with your system administrator to find out if you should compress your
data during a backup.
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The Backup Status dialog box appears, so you can monitor the backup process.

Note – If you do not see files scrolling in the display, or if an error message
appears, contact your system administrator.  The server may be busy, have a
configuration problem, or a backup volume may not be mounted in the device.

When your backup is complete, you see a message similar to the following in
the Backup Status dialog box:

Backup backs up marked files to the volume mounted in the server backup
device.  Backup also creates an entry in the index for each file it backs up, so
you can find them for quick recovery.

Click the Cancel button to close the Backup Status window.  Click the
minimize button in the window header to reduce the Backup window and
display the Backup icon.  If you want to exit Backup (stop the program), select
Exit from the File menu.

Backup Completion Time: Fri Nov 3 14:20:42 1995
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Recovering a File

The Recover window displays the index entries Backup creates when it backs
up the data on your system.  Index entries are organized exactly like the
filesystem displayed in the Backup window, so you can easily navigate
through your directories and files.

The Quick Tour takes you through the following steps to practice recovering a
file:

• opening the Recover window
• browsing the files contained in an index
• marking the files you want to recover
• starting the recover

Opening the Recover Window

Click the Recover icon displayed on your screen.  The Recover window
appears, as shown.
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Note – The Recover window displays index entries for the files on the Backup
server.  By contrast, the Backup window displays the actual files in your
filesystem.  The Recover window shows entries for files that have been backed
up and are available for recovery.  The entries are organized exactly like an
actual filesystem, so it is easy for you to navigate the directories.

▼ Browsing the Index

You can browse the index to locate a file you want to recover.

1. Notice that the current directory is highlighted.

a. Select Expand One Level from the Tree pull-down menu.
The subdirectories are displayed in a tree structure in the directory display.

Note – Clicking a closed directory folder twice (double-clicking) expands or
collapses it one level.

▼ Marking a File

To mark a file or directory for a recover:

1. Click the directory folder that contains the file you want to recover.
The file display shows the most recently backed-up version of the files
contained in the directory.

2. Click the check box in the file display next to the file you want to recover,
as shown in the following example.
If you want to recover an entire directory, mark its check box in the
directory display.
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▼ Starting the Recover

So far, you have browsed the index and marked files for recovery.  The next
step is to start the recover.

1. Click the Start speedbar button to start the recover.
The Conflict Resolution dialog box appears, as shown.
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Use the Conflict Resolution dialog box to resolve naming conflicts that
might occur during recovery.  Naming conflicts occur when the requested
recover file has the same name as an existing file.

2. Click No for Do you want to be prompted when conflict occurs?, so that
Backup does not prompt you for each naming conflict.

3. Click one of the When conflict occurs, Backup should? choices.  The
default choice, Rename the recover file, is already selected.
This option adds an “.R” extension after the name of the recovered file when
a naming conflict occurs.

Note – We recommend you select the default choice, Rename the recover file,
to ensure that existing files are not accidentally overwritten.

4. Click Ok to close the Conflict Resolution dialog box and continue the
recover.
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The Recover Status dialog box appears, as shown, so you can monitor the
recover process.

The Recover Status dialog box provides the following information:

• number of files to recover and their recover location
• estimated disk space needed
• name(s) of the backup volumes needed
• device location of the required backup volume(s)
• number of files being recovered and their names
• new file names, if you selected Rename the recover file

Click the Cancel button to cancel the recover or close the Recover Status
dialog box when the recover is finished.

A message similar to the following appears when the file recover completes:

5. Confirm your file recover by listing the contents of the directory from a
UNIX command prompt.
Since Rename the recover file was selected in the Conflict Resolution dialog
box, the recovered file shown in the example has an “.R” file extension.

Recover completion time: 11/03/95 15:26:45
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Quick Tour Review

During the Quick Tour of Backup, you learned how to perform the following
tasks:

• use the Backup GUI
• use the Backup window to back up a subdirectory to the Backup server
• exclude a file from the backup
• monitor the status of the backup
• use the Recover window to browse the index for your backed-up files
• mark a file for recover in the Recover window
• recover a file
• use the Conflict Resolution dialog box to resolve naming conflicts during

recover
• monitor the status of the recover

The Quick Tour is meant to familiarize you with the Backup and Recover
windows. Chapter 3 shows how to view and mark your files and directories.
Chapter 4 provides detailed information on performing backups and recovers.

If you have the optional Backup Archive Application, see Chapter 5,
“Archiving and Retrieving Files” for information specific to the Archive and
Retrieve windows.
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This chapter shows how to browse filesystems in the Backup, Recover, and
Archive windows.  Backup filesystem displays allow you to view directories,
mark and unmark files, search for files, view file details, and change the
current directory displayed.  When recovering files, the index of saved files is
displayed exactly like your filesystem, making it convenient to select files for
recover.

Note – This chapter describes browsing features common to all three
windows.  Features specific to the Backup and Recover windows are described
in Chapter 4, “Backing up and Recovering Files.”  See Chapter 5, “Archiving
and Retrieving Files,” for features specific to the Archive and Retrieve
windows.
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Viewing Your Directories
The Tree pull-down menu contains three commands for changing the level at
which you view the directories in a filesystem:  Expand One Level, Expand
Branch, and Collapse Branch.  You can expand a directory one level to view its
subdirectories, or expand a branch to view all levels of a directory.  This makes
it easy to find files deeply embedded in your filesystem.

▼ Expanding One Level

The Expand One Level command displays the subdirectories one level below
the selected directory.  Subdirectories are graphically displayed as a tree
structure.  You can scroll the directory display to find the subdirectory
containing the file you want.

To expand a directory one level:

1. Click a directory folder in the directory display.

2. Select Expand One Level from the Tree pull-down menu or
double-click the directory folder.

▼ Expanding a Branch

The Expand Branch command displays all levels of subdirectories contained in
a directory.

To expand a directory to view its branch:

1. Click a directory folder in the directory display.

2. Select Expand Branch from the Tree pull-down menu.

Note – Large directories and branches might take longer to expand.
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▼ Collapsing a Branch

The Collapse Branch command closes all subdirectories and returns you to the
level of the highlighted directory.

To collapse a branch (close all subdirectories):

1. Click an expanded directory in the directory display.

2. Select Collapse Branch from the Tree pull-down menu, or
double-click the directory folder.

▼ Marking and Unmarking Files

You choose files and directories for backup and recover by marking them.  The
icons have a check box beside them that displays a check mark when the file is
marked.  To mark or unmark files and directories, use the Mark and Unmark
speedbar buttons or click the check box next to the file or directory.

To mark (or unmark) a file or directory using the speedbar buttons:

1. Click a file or directory icon.

2. Click the Mark speedbar button.  This places a check mark in the check
box beside the highlighted icon, marking it for backup or recover.

3. Click the Unmark speedbar button to remove the check mark.  This
removes the check mark and excludes the file from the backup or recover.

Note – If you click the Mark or Unmark speedbar button without first selecting
a directory or file icon, the directory displayed in the Selection field is the one
marked or unmarked.

To mark (or unmark) a file using the check box next to the file icon:

1. Click the check box next to the file.  This places a check mark in the check
box.

2. Click the check box to unmark a marked file.
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Note – Marking a directory also marks its subdirectories and nested files.  The
check boxes of parent directories are shaded to show that some or all of the
directory contents are marked for backup or recover.

Viewing Your Files
The View pull-down menu contains commands for searching directories for
specific files and for changing the level of detail displayed for the directories
and files.

▼ Searching for Files

If you know the name or partial name of a file or directory, you can use the
Search command to locate it in the filesystem or index.  Use the Search
speedbar button to bring up the Search dialog box, or choose Search from the
View pull-down menu, as shown.

To search for a file, specify the filename or partial filename and the pathname
where you want to begin the search.  Backup begins searching in that directory,
then searches through the subdirectories and nested files within the path.

To search for files or directories by name:

1. Click the Search button in the speedbar to open the Search dialog box or
select the Search command from the View pull-down menu.
The Search dialog box appears, as shown.

2. Enter the name of the file or directory in the Search for field.  You can use
standard UNIX shell pattern matching characters when specifying partial
filenames.
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3. Enter a valid pathname for the desired directory in the
Begin search in field.  Backup will search through that directory and all
nested subdirectories.

4. Click the Ok button.  The pathname of the first match appears in the
Selection field and is also highlighted in the file display.

5. Click the Continue button to highlight the next match and display it in
the Selection field.
You can continue the search until Backup finds the last match. If Backup
cannot find a match for the selection, a dialog box message appears.  Click
OK to close the dialog box.

6. Click the Cancel button to close the Search dialog box.

▼ Viewing File Details

You can choose to view file names only or complete file details in the file
display by selecting the File Details command in the View pull-down menu, as
shown.  Clicking the button for this command toggles between the two choices.

The default viewing selection displays file names only, listed in alphanumeric
order.  The File Details command changes the view to display the filename,
number of blocks, permissions, number of symbolic links and where they
point, owner, group, size, date, and time each file was last modified.

In the Recover window, the File Details command also displays the backup
time for each file.  Use this information to identify different backup versions of
a file.
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To display file details:

1. Select File Details from the View pull-down menu.
The file display in the Recover window changes to show file details.  Notice
the Backup time listed for each file.

2. Adjust the size of the window or use the horizontal scrollbar at the
bottom of the file display, if necessary, to display the contents of the
window.
To return the file display back to file names only, select the File Details
command once more.

▼ Changing a Selection

The Backup, Recover, and Archive  windows display the full pathname of the
current directory in the Selection field.  If you know the path of a directory or
file, you can go directly to it by entering the full pathname in the Selection field.
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To change the current selection:

1. Enter the full pathname for the new selection in the Selection field, as
shown in the following example.

2. Press the [Return] key.
Both the directory and file displays change to show the new selection.
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This chapter describes the Backup and Recover windows.  It includes the
backup and recover functions unique to each window.  See Chapter 3,
“Browsing Filesystems,” for information on using functions common to both
windows.  For a quick tour of the backup and recover programs, see Chapter 2,
“Getting Started.”  If your site has the optional Backup Archive Application, be
sure to read Chapter 5, “Archiving and Retrieving Files.”

Backing up Files
This section assumes you already know how to mark files for a backup.  For
detailed instructions on viewing directories, marking and unmarking files,
searching for files, or viewing file details, see Chapter 3, “Browsing
Filesystems.”

If you are already familiar with the Backup window, see the shortcut
instructions on page 41.

▼ Changing the Backup Server

Backup backs up your data according to a backup schedule determined by
your system administrator.  Usually, a single Backup server backs up all the
systems on a network.  You may need to change servers if your Backup server
is down or you are experiencing network difficulties.
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If you have more than one Backup server available on the network, you may
have a choice of servers for your backups.  In order to switch to a different
Backup server, your system must be listed as a client of that server.  Check
with your system administrator before you switch to a server other than the
one that normally backs up your system.

To change Backup servers:

1. Click the Change Server speedbar button, or select Server from the
Change pull-down menu in the Backup window.

The Change Server dialog box appears, as shown.

2. Enter the hostname of the server in the Server field or click a name in the
list of servers displayed.
If you do not see the hostname of the server you need, click the Update
Server List button to update the list of Backup servers available on your
network.

Caution – When you click the Update Server List button, Backup searches for
every server available to your machine.  If you have a large network, this
search could take awhile.

3. Double-click the hostname to choose the new server or click Ok to choose
the server shown in the Server field.

!
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Note – If you choose a Backup server that does not have your system listed as
a client, you receive a notice similar to the following.  If this occurs, contact
your system administrator.

▼ Starting a Backup

Use the Start speedbar button to start a backup on marked files or choose Start
Backup from the File pull-down menu, as shown.

To start a backup:

1. Mark the files you want to back up.

2. Choose the Backup server (if necessary).

3. Click the Start speedbar button.
The Backup Options dialog box appears, with choices for the options
Backup applies to your backup.

Choosing the Backup Options

Backup displays the Backup Options dialog box before starting the backup.
This gives you the opportunity to compress files and exclude patterns before
the backup starts.  Compressing data reduces network traffic and saves space
on the backup media.  Excluding patterns is convenient for specifying data you
do not want to back up at all.
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Compressing Files

To choose whether to compress the files you back up, select a choice for Do you
want to compress this backup? in the Backup Options dialog box.  Notice that
Yes is already highlighted as the default selection, as shown.

If you want Backup to compress your files during backup, you do not have to
make a selection for the compression option, since Yes is the default selection.

If you back up to a device that compresses data, do not use the Backup file
compression feature.  Click No to continue the backup without file
compression.

Note – Compressing your data during backup saves space on the backup
media and reduces network traffic, but may slow down the backup operation.
Check with your system administrator to find out if you should compress your
data during a backup.

Notice that No is highlighted as the default selection for the Do you want to
exclude any patterns from this backup? choice.  If you do not want to exclude
patterns of filenames from the backup, click Ok to continue the backup.

▼ Excluding Patterns

You can exclude files from the backup using the Pattern options provided in
the Backup Options dialog box.  This feature is useful, for example, if you are
backing up an entire directory and do not need to back up certain files or
subdirectories in that directory.  Excluding files from the backup also reduces
network traffic and saves space on backup media.



Backing up and Recovering Files 39

4

To exclude files from the backup, specify alphanumeric patterns that occur in
the names of the files you want to exclude.  Use UNIX shell pattern matching
characters to specify any number of patterns you want to exclude.

To exclude patterns from the backup:

1. Click Yes for the Do you want to exclude any patterns from this backup?
choice.
This activates the lower half of the Backup Options dialog box.

2. Enter the first pattern in the Pattern field.

3. Click Add to add the pattern to the list.
The pattern appears in the pattern list display, as shown.

If you want to change a pattern, select it in the pattern list.  The selected
pattern appears in the Pattern field.  Enter the new pattern and click
Change.  The new pattern replaces the old pattern in the pattern list.

If you want to delete a pattern, select it in the pattern list and click Delete.

4. Enter any remaining patterns and add them to the pattern list.

5. Click Ok to continue the backup with the excluded file patterns and the
compression choice.
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Monitoring the Backup Status

The Backup Status dialog box appears after you complete your selections in the
Backup Options dialog box and click Ok.  Use the Backup Status dialog box to
monitor the backup process.

The Backup Status dialog box provides the backup start time and the backup
completion time.  The names of the files and directories scroll across the
Backup Status dialog box as the backup proceeds.  The message at the bottom
of the dialog box gives you information about the backup, including the full
pathname of the directory, the amount of data, the amount of time it took, and
the number of files saved.

If you do not see any progress messages in the Backup Status dialog box after
a few minutes, the Backup server probably needs attention from the system
administrator.  Click the Cancel button to cancel the backup.

A message similar to the following appears in the Backup Status dialog box
when the backup completes:

Backup completion time: Fri Nov 3 14:20:42 1995
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Click the Cancel button to close the Backup Status dialog box.

▼ Shortcut

Read this section if you are already familiar with the Backup window.

To back up your directories or files:

1. Click the Backup icon to open the Backup window.

2. Click the check boxes, or highlight the directory or file you want to back
up, and click the Mark speedbar button.

3. Click the Start speedbar button.

4. Click the Ok button in the Backup Options dialog box.

5. Click the Cancel button in the Backup Status dialog box to close it after
you check the backup completion message to make sure the backup is
finished.

Recovering Files
This section assumes you have already marked your files for recovery in the
Recover window.  For detailed instructions on viewing directories, marking
files, searching for files, or viewing file details, see Chapter 3, “Browsing
Filesystems.”  If you are already familiar with the Recover window, see the
shortcut instructions on page 54.

Backup displays entries in the Recover window for the files it saved during a
backup.  Select the files you want to recover from this list of entries.  Recover
functions allow you to browse the index for previous backups, select various
versions of the file to recover, view your marked files, relocate files upon
recovery, and recover files from another authorized system.

Note – An authorized system is a client for which you have permission to
recover data.
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Starting a Recover

Use the Start speedbar button to start a recover on marked files or choose Start
Recover from the File pull-down menu, as shown.

Before starting a recover, read the following sections which explain the Recover
features.

▼ Choosing the Recover Server

Normally you recover files from the Backup server designated by your system
administrator.  If you changed backup servers in the Backup window, you
must select the same server in the Recover window to recover files backed up
to that server.

Caution – The Change Server dialog box lists all the Backup servers on the
network.  You can only back up and recover files from a server that lists your
system as a client.

To choose a recover server in the Recover window:

1. Click the Change Server speedbar button, or select Server from the
Change pull-down menu.
The Change Server dialog box appears.

!
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2. Click the Update Server List button to update the list of Backup servers
on the network, if needed.
Double-click the server name to choose the server that has the files you need
to recover.  The Server field changes to reflect the current selection.

3. Click the Ok button after you select a server.
Backup updates the directory and file displays in the Recover window.

Note – Select the recover server you want before marking the files to recover.

▼ Choosing the Recover Client

If you need to recover files for a client other than the system currently in use,
select the Change Client command in the Change pull-down menu.  The
Change Client command opens a dialog box that lists all of the clients for the
currently-selected Backup server.  Check with your system administrator if you
want to recover files other than your own.  You may not be authorized to
recover files for other client systems.

To choose a recover client:

1. Choose Client from the Change pull-down menu in the Recover window.
The Change Client dialog box appears, as shown.

2. Click Update Client List button to update the list of Backup clients
available on the selected server.

3. Choose a client for which you are authorized to recover files.
The Client field changes to reflect the current selection.

4. Click the Ok button after you select a client.
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▼ Selecting File Versions

The View pull-down menu in the Recover window contains two commands
not found in the Backup window:  Versions and Volumes.  Details of the
Volumes command are in “Listing the Backup Volumes for a Recover” on page
49.

The Versions dialog box lists all the versions of a file or directory that have
been backed up by the Backup server.  The dialog box also lists the backup
volumes on which the files reside.  Use the Versions command to view the
backup history of a file and to mark a particular version of a file for recovery.

Caution – Backup displays versions of backed-up files and directories in the
Versions dialog box.  You can only mark files for recovery in the Versions dialog
box.  If you attempt to mark a directory in the Versions dialog box, you receive
a warning similar to the following:

In addition to providing the backup time and location of all backed-up
versions of the selected file, the Versions dialog box provides the following
information:  number of blocks, mode, permissions, number of links, owner,
group, size in bytes, and last modified time.  The filename, including the
complete path, is displayed at the top of the dialog box.  To identify different
versions of a file, compare the Backup time indicated for each version.

The Location field includes the name of the backup volume and the device
where the volume is mounted or the location of the backup volume (for
example, offsite storage).  If no device is listed, it means that the backup
volume must be mounted before you can recover the file.

!
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To view the backup history of a file or directory in the Recover window:

1. Click a file or directory in the file display.

2. Select Versions from the View pull-down menu.

Backup retrieves several versions of the highlighted file or directory from
the index and lists them by backup time, beginning with the most recent.
Use the scrollbars to view the complete backup history.

3. Click More to retrieve additional versions from the index.  The More
button becomes inactive after all versions are retrieved.

To mark a version of a file for recovery:

1. Click the check box of the file version you want to recover.

2. Click Ok to place the marked versions in the file display.

Note – When you mark a past version of a file in the Versions dialog box, it
appears in the Recover window file display with the same name as the most
recent version.  Use the File Details command to display backup times to
distinguish the multiple file versions displayed.
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▼ Changing the Browse Time

The Browse Time field, shown below, displays the date and time you started
the current Recover program session.

The Recover window displays the index entries for files backed up at the time
shown in the Browse Time field.  Use the Browse Time command in the
Change menu to change the Browse Time displayed to another date.  Changing
the browse time displays the entries for files backed up immediately before the
new browse time.

Note – If there are no entries for files backed up for the selected time in the
Browse Time field, Backup displays files that were backed up closest to that
time, but not immediately after.  For example, if you change Browse Time to 10
a.m. on May 15, and the backup took place at 11 a.m. on May 15, Backup will
not display the entries for the files backed up at 11 a.m.

Changing the browse time lets you view past versions of your files.  This is
useful if you do not remember the name or location of the files you want to
recover, but do remember they existed at some time in the past.  The Browse
Time command in the Change pull-down menu also helps you find deleted
files that no longer appear in the Versions dialog box.  You can recover deleted
files by changing the Browse Time to locate past versions of the files in the
index.

Note – Use the Browse Time command to browse and mark past versions of
directories.  Marking a directory causes all its nested files and subdirectories to
be marked.
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To change the browse time to recover a past version of a file:

1. Select Browse Time from the Change pull-down menu in the Recover
window.

The Change Browse Time dialog box appears, as shown.

The Previous, Today, and Next buttons control the month displayed.  After
choosing a month, click a day in the calendar to select the browse time.

Note – You can also change the browse time by entering a date and time in the
Browse Time field and pressing [Return] or clicking Ok.  The following formats
are valid browse time entries:

hh:mm:ss (24 hour clock) or hh:mm:ss (am or pm) mm/dd/(yy) or
monthname dd (yy)
last Friday, next Friday, or third Friday
+ or - 3 seconds, minutes, hours, weeks, months, or years
now (the current date and time)



48 Solstice Backup 4.2 User’s Guide—April 1996

4

2. Click Ok after choosing a browse time.
The Browse Time field in the Recover window changes to reflect the new
browse time.  The file display and directory display of the Recover window
show files that were backed up at or before that time.  You may now mark
past versions of files for recovery.

Note – Any files or directories you marked for recovery before changing the
browse time remain marked.

▼ Showing Marked Files

List the files you marked for recovery by selecting the Show Marked command
from the Mark pull-down menu.  This command is only available in the
Recover window.  Use the Show Marked command to review files marked for
recovery before starting the recover operation.

To show the files marked for recovery:

1. Select the Show Marked command from the Mark pull-down menu of the
Recover window, as shown.
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The Files Marked for Recovery dialog box appears, listing the pathnames and
backup time of all marked files.

2. Click Cancel to close the dialog box.

Note – The Files Marked for Recovery dialog box lets you verify that all the
files you need to recover are marked before starting the recover.

▼ Listing the Backup Volumes for a Recover

After you mark your files for a recover, you can find out if the backup volumes
Backup needs are available.  If Backup cannot access the backup volume
containing your file, it sends a message to the system administrator to load the
volume.  This request could take some time to fulfill.  You may want to delay
the start of the recover until the volume is available.

Use the Volumes command in the View pull-down menu to determine if the
backup volume needed to recover a file is available.
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To determine if the file you want to recover is immediately available for
recovery:

1. Mark the files or directories you want to recover in the Recover window.

2. Select the Volumes command from the View pull-down menu.
Backup displays a dialog box, similar to the following:

If the backup volume is available, which means the volume is mounted or in
an autochanger, “all on-line” appears in the Recover Volumes Required
dialog box.  The dialog box displays the name(s) of the backup volume(s)
and, if applicable, their location.  In the example shown, the volume named
“titania.006” is located in an autochanger device named /dev/nsrt8 .

▼ Relocating Files

To recover files to a directory other than the one they were backed up from, use
the Relocate command before you start the recover.  The Relocate command
creates the directory, if it does not already exist, and recovers your file to the
new location.

To relocate recovered files into a new or existing directory:

1. Select the Relocate command from the Options pull-down menu in the
Recover window.
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2. Enter the complete pathname of the directory where you want to place the
recovered files in the Relocate to field.

3. Click Ok to relocate the files into the new directory.

▼ Renaming or Overwriting Recovered Files

When you start a recover, Backup displays the Conflict Resolution dialog box.
You must decide whether to rename recovered files or overwrite existing files
when a naming conflict occurs.  A naming conflict occurs when a file you are
recovering already exists or has the same name as a file in the current
directory.  Backup will not overwrite existing files unless requested to do so.

The Conflict Resolution dialog box has two sections requiring a selection for
resolving naming conflicts, as shown.
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1. Choose a response for the Do you want to be prompted when conflict
occurs? question.  The default choice, Yes, is already highlighted.
Clicking No allows you to resolve conflicts for the entire recover session
without being prompted about individual files.  If you choose No, you must
also choose a response for the When conflict occurs, Backup should?
question.

Clicking Yes allows you to resolve conflicts on a file-by-file basis.  Backup
prompts for instructions in the Filename Conflict dialog box every time it
encounters a naming conflict.  Each time this occurs, you must select a
choice for the Do you want to? question in the Filename Conflict dialog box,
as shown, then click the Ok button.

The following are choices for conflict resolution:

Rename the recover file – Backup renames the recover file with an “.R”
extension.  If the “.R” file already exists, Backup adds another “.R”
extension to the recover file name.

Discard the recover file – Backup discards the recover file.  The existing file
remains current.

Overwrite the existing file – Backup replaces the existing file with the
recovered file.  The existing file is lost and the recovered file becomes
current.

2. Click Ok to continue the recover after completing the Conflict Resolution
dialog box or click Cancel to return to the Recover window.
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Monitoring the Recover Status

After the Conflict Resolution dialog box closes, the Recover Status dialog box
re-appears as the recover continues.

The Recover Status dialog box provides you with the following information
about your recover session:

• The number of files to be recovered and where they will be relocated. If you
specified a directory in the Relocate dialog box, it is listed.

• The estimated disk space required for the recover.

Recovering 4 files within
/usr/export/home/jupiter/vbrown/ into
/usr/export/home/titania

Total estimated disk space needed for recover is 16 KB.
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• The name of the required backup volume and its location.

• The name of the file or directory being recovered.

• The new filenames, if you chose to rename recovered files.

To cancel the recover or to close the Recover Status dialog box, click the Cancel
button.  When the recover completes, a message showing the recover
completion time appears in the Recover Status dialog box.

▼ Shortcut

Read this section if you are already familiar with the Recover window.

To recover your directories or files:

1. Select the Recover icon to open the Recover window.

2. Change servers, if necessary, by clicking the Change Server speedbar
button.  If applicable, change clients by choosing Client from the Change
menu.

3. Use the mouse to highlight the icons for files or directories you want to
recover, then click the Mark speedbar button.

4. Choose Volumes from the View pull-down menu to see if the backup
volumes are immediately available for your recover.

5. Click the Start speedbar button to begin the recover.

6. Click the Ok button in the Conflict Resolution dialog box.

Volumes needed: (all on-line)
titania.015 at /dev/nrst8

Requesting 4 files, this may take a while . . .
./home.html

renaming ./home.html to ./home.html.R
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7. Click the Cancel button to close the Recover Status dialog box after the
recover completion time message appears.

Summary
To use Backup successfully, you must be able to perform the following tasks:

• back up files
• monitor the backup status
• view the backup volumes needed for a recover
• recover files
• relocate or rename files during a recover
• monitor the recover status

For information about configuring the Backup server, refer to the Solstice
Backup 4.2 Administration Guide or ask your system administrator.

The next chapter, “Archiving and Retrieving Files,” explains how to use the
optional Archive Application.
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Archiving and Retrieving Files 5

This chapter describes how to archive and retrieve files and directories using
the optional Archive Application.

Archiving Files
The Backup and archive processes serve very different purposes.  The backup
process is short-term insurance against data loss.  Backup keeps track of
backups in the online file index to enable users to quickly recover lost or
corrupted files.  This online file index requires considerable disk space.
Because archives theoretically are kept forever, Backup does not track them in
the online file index – Backup only tracks archives in the online media index.

The Archive is a long-term strategy for preserving data on media called
archive volumes.  Archive volumes are similar to backup volumes, except they
do not have an expiration date, which simply means that Backup will keep
track of them forever.

Once files are safely stored on archive volumes, the archived files can be
removed from local disk, freeing up space on your system.  If you ever need to
restore archived files to your system, you may do so at any time using the
Retrieve window.

To a user, archiving files is like backing up files, except that the Archive
Application allows you to automatically groom archived files and directories.
Grooming means that files and directories are deleted from your filesystems
after they have been successfully archived.
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To a system administrator, backup has a different purpose than archive.  The
goal of backing up filesystems is to protect against loss of data due to
hardware failure or user error.  The goal of archiving is to make more space
available on disk while maintaining a snapshot of removed files for quick
retrieval in the future.

Since archived files are not tracked in the online file index, the Retrieve
window does not display archived files and directories in the same manner as
other Backup windows.  Archives made on the server appear in alphabetical
order in the Archives display of the Retrieve window.

Note – To remember what an archive contains, record the archive date and
create a meaningful annotation.  See “Starting an Archive” on page 60 for
details.

Starting Backup Archive

If the Archive Application is running on your system, you see the
 Archive icon or the Archive window on your screen.  Click the icon, shown
below, to open the window.
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The Archive window appears, as shown..

If you do not see the Archive icon or the Archive window, start the application
from a command line on your system.

To start the Archive Application from a command line, enter the nwarchive
command, followed by the server name and an ampersand (&) to run the
application in the background:

If you have a multi-server network and do not specify a server name, Backup
chooses an archive server for you.

# nwarchive -s server_name  &
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▼ Starting an Archive

To start an archive:

1. Change archive servers, if needed.
The Change Server command is described in Chapter 4, “Backing up and
Recovering Files.”

2. Mark the directory or files you want to archive.

Note – Marking a directory also marks all the subdirectories and files it
contains.  If you want to archive most (but not all) files in a directory, first mark
the directory, then unmark files you do not want to archive.

3. Click the Start speedbar button, or choose Start Archive from the File
pull-down menu.
The Archive Options dialog box appears, as shown.  The Archive Title field
shows the pathname of the currently-selected directory or file.

4. Type a comment in the Annotation field that will help you remember the
contents of the archive for future retrieval.
When choosing a meaningful annotation, keep in mind that annotation
searches are case-sensitive.  The Annotation field accepts up to 1024
characters, including spaces and punctuation.
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Note – If you do not enter an annotation before starting the archive, a dialog
box appears, reminding you to enter an annotation.

5. Specify a volume pool for your archive in the Archive Pool field.
Click the arrow button next to the Archive Pool field to view a list of the
choices available.  Click the arrow button again to close the list.  If an
Archive Pool is not specified, the volume pool defaults to “Archive.”  If you
do not know which pool to choose, contact the system administrator.

6. Click any of the available options in the Operations list.
If the box next to an option is highlighted, the option is selected.  The
following choices are available options:

• Compress – to compress archive data, click Compress.  If you have a
compressing tape drive, do not choose the Compress option.

• Clone – to clone archive data on a different archive volume, click Clone.
Backup makes a copy of your archived data.

• Verify – to verify that the data on archive media matches the data on local
disk, click Verify.

• Groom – to remove files and directories from local disk after archiving is
complete, click Groom.

See the sections following these instructions for an explanation of the Clone,
Verify, and Groom options.

7. Click the Archive button when you are ready to continue.
The Archive Status dialog box appears, showing the archive process. Click
Cancel if you need to stop the archive process.  A dialog box appears, asking
for confirmation.  Click OK to kill the archive, or Cancel to continue.
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Cloning Your Archive

Cloning makes a duplicate copy of your archive.  Two backup devices are
required to make a clone.  Each backup device must have a valid, writable
archive volume mounted.  Check with your system administrator before
making clones of your archives.

When you select Clone in the Archive Options dialog box, Backup duplicates
your archived data on another archive volume.  If you specify a Clone Pool, the
archive clone is sorted to a volume associated with that pool.  Otherwise, the
archive clone goes to “Archive Clone,” the default clone pool,

Click the arrow button next to the Clone Pool field to view a list of the choices
available.  Click the arrow button again to close the list.

Verifying Your Archive

When you select Verify in the Archive Options dialog box, Backup checks the
data written on the archive volume.  If you also select Clone in the Archive
Options dialog box, the clone volume is verified.  The archive completion
report in the Archive Status dialog box alerts you to any problems with the
archived or cloned data.

Grooming Your Filesystem

When you select Groom in the Archive Options dialog box, Backup deletes all
marked files after the archive successfully completes.  Select the Verify option
when you choose Groom to ensure files are properly archived before they are
groomed from your disk.

Caution – When you select the Groom option, be careful not to mark any files
that you must retain on disk.  Check with your system administrator before
using the Groom option.!
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Monitoring the Archive Status

Use the Archive Status dialog box to monitor the archive process.

The Archive Status dialog box provides the archive start time and the archive
completion time.  The names of the archived files and directories scroll across
the Archive Status dialog box as the archive proceeds.  When the archive
completes, the full pathname of the directory, the amount of data, the amount of
time it took, and the number of files archived are displayed.  The Archive
Completion Information gives you details about the archive, including the
volume your save set was archived to and the Annotation you assigned to the
archive.

Note – Write down the annotation and volume information and include it with
your project documentation to make it easier to retrieve the data at a later date.
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Retrieving Files
Retrieval involves the copying of files back to local disk from archive volumes.

Starting Backup Retrieve

If the retrieve utility for the Archive Application is running on your system,
you see the Retrieve icon or the Retrieve window on your screen.  Click the
icon, shown below, to open the Retrieve window.

If you do not see the Retrieve icon or the Retrieve window, start the application
from a command line on your system.

To start Retrieve from a command line, enter the nwretrieve  command,
followed by the server name and an ampersand (&) to run the application in
the background:

If you have a multi-server network and do not specify a server name, Backup
chooses a retrieval server for you.

The Retrieve Window

The Retrieve window has fewer menus than the other Backup windows.  Since
archived save sets are not maintained in the online file index, the Tree, View,
and Mark menus are not present.  The File, Change, Options, and Help menus
are navigated in the same manner described for the Backup, Recover, and
Archive windows.

When you start the nwretrieve  program, the Archives scrolling list is empty.
The currently-selected server is indicated directly beneath the speedbar.  To
display a list of archive save sets available on the currently-selected server,
click the Query button.

# nwretrieve -s server_name  &
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The window displays a list of the archived save sets available for retrieval.

To search for a particular save set using all or part of its annotation, enter all or
part of the annotation in the Search annotation for field and click the Query
button.  All archive save sets with matching annotations appear highlighted in
the Archives list.

Note – Since the search for annotations is case-sensitive, use regular
expressions like [Aa] to search for upper or lower case.

Archive Save Set Details

To see details about the currently-highlighted archive save set, click the Details
button.  The Retrieve Details dialog box appears.
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The fields in this dialog box provide the following information:
name – full name of the save set (including path)

date – date the save set was archived

files – number of files in the save set

ssid – save set ID

size – file size, in bytes

The Retrieve Details dialog box also shows the archive annotation, which can
be used in the Search annotation for field in the Retrieve window.

Note – The currently-highlighted save set is the only one whose details are
displayed in the Retrieve Details dialog box.  To view details on another save
set without exiting the Retrieve Details dialog box, highlight the new save set
in the Archives list.

▼ Retrieving a Save Set

To retrieve a save set to your system:

1. Click the line containing the required save set in the Archives list in the
Retrieve window.

Note – You may select multiple save sets for retrieval.  To avoid overwriting
later copies of files when the Overwrite existing files option is selected, Backup
retrieves the files in chronological order.

2. Select Start Retrieve from the File menu.
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The Retrieve Status dialog box appears, as shown.  The Archives list displays
all archive save sets you selected for retrieval in the Retrieve window.

3. Specify a new or existing directory in the Relocate to field, if needed.  By
default, retrieved files are copied to their original location.

4. Click Overwrite existing files, if you want Backup to replace existing files
on the local disk with files retrieved from the archive volume.  If you do
not select this option, Backup prompts you to resolve naming conflicts.

5. Click the Ok button when you are ready to start the retrieve.
The appropriate archive volume(s) must be mounted (mounting is
automatic in an autochanger).
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During the retrieve operation, messages appear in the Status field to inform
you of progress.

To stop a retrieve in progress, or to dismiss the Retrieve Status dialog box
before retrieval has begun, click the Cancel button.

Summary
Archiving files is like placing them into a bank safe deposit box.  They are
meant to remain safe and last forever.  But just as paper in safe deposit boxes
can age and yellow, tapes used to archive files do not last forever.  Optical discs
last longer, but are still vulnerable to fire.  Choosing the Clone option, which
makes an extra copy of the archive, increases the protection of vital data.

Deleting files from disk, using the Groom option, conserves the space for
current projects.  However, if your site policy is to move archives offsite for
increased protection, retrieving archived files could take awhile.  Contact your
system administrator to find out whether the archive volume you need is
available for immediate retrieval.



69

Error Messages A

Backup provides user-friendly error messages with instructions to help you
solve most backup, archive, and recover problems you encounter.

Error Messages for Backup and Archive
Backup displays an error message if a backup or archive cannot be completed.

Message Cause Solution

Nothing marked for
backup.

You started a backup
without marking any
files.

Mark at least one file before
starting the backup or archive.

Unable to start backup. Backup was unable to
execute the save
command.

Contact the system
administrator.  There is a
problem with the Backup
software or your client
configuration

Your system is not a
registered client.

The server you selected
does not have your
system listed as a
Backup client.

Contact the system
administrator.  Your system
needs to be added to the list of
recognized clients for the
selected server.
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Error Messages for Recover and Retrieve
Backup displays an error message if it cannot recover or retrieve a file.

Message Cause Solution

These are files marked
for recovery.  Continue
to ignore the marked
files, or cancel to stay
with this client.

You tried to change
clients or filesystems
after marking some files
for recover or retrieve.

You have the option to continue
changing the client. In this case,
the marked files will not be
recovered.  Or you can cancel to
stay with the current client and
retain your marked files.

(For root users)
Only 10 KBytes
available to non-
superusers (15 KBytes
free) in /directory.
Filesystem will be
greater than 100% full
after recover is
complete.  Proceed with
recover command at this
time? [n]

(For non-root users) No
disk space available to
non-superusers (15
KBytes free) in
/directory. The estimated
recover size of 10 KBytes
will not fit on this
filesystem.  Proceed with
recover command at this
time? [n]

There is not enough free
space in the filesystem
to recover or retrieve the
requested files.

Reduce the size of the recovery
by reducing the number of
marked files.  Relocate the
recovered files into another
directory with more space.  If
you are recovering over existing
directories, you may be able to
proceed with the recovery since
files will be overwritten.

Invalid time format. The time you entered in
the Browse Time field
was an invalid format.

Enter the browse time using a
valid format.  Examples of valid
browse time formats are shown
on page 46 of this guide.
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Error Messages for All
Some Backup error messages are the same for an unsuccessful backup, recover,
archive, or retrieve.

Nothing in index at this
time.

There are no entries in
the index for the browse
time that you specified,
or no backups were
done at that time.

Enter another browse time until
you find the index entries for
which you are looking.

Unable to relocate to
/directory.

Backup was unable to
relocate the recovered
data to the path you
specified.

Enter a valid pathname in the
Relocate dialog box and start
the recovery again.  You must
have write permission for the
directory you wish to use.

Message Cause Solution

There are files marked
for backup or recovery.
Continue to ignore the
marked files or cancel to
stay with server.

You cannot change
servers after you have
marked files.

You have the option to continue
changing servers.  If you change
servers, the marked files will
not be backed up or recovered.
You can cancel to stay with the
current server and retain your
marked files.

Bad start path. You specified an invalid
starting path for a
search.

Enter a valid pathname as a
starting point in the Search
dialog box.

No match. The Search command
did not find any
matches.

Enter a different search pattern
or starting path.

Bad search pattern. The search pattern you
specified is not valid.

Use UNIX shell pattern
matching characters to specify a
search pattern.

Message Cause Solution
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Unable to expand path. The path you specified
in the Selection field
does not correspond to
anything in the index or
filesystem.

Enter a valid pathname in the
Selection field.

Message Cause Solution
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In addition to a graphical user interface (GUI), Backup has UNIX-like
commands.  These commands are entered from a UNIX shell to back up and
recover data.  You must have access to a Backup server and your system must
be configured as a Backup client in order to use these commands.

Both the save  and recover  commands can be run from the command line
with arguments.  Refer to the save  and recover  man pages for more
information about saving and recovering data from the command line.

Enter the save  command at the system prompt to back up data:

Enter the recover  command at the system prompt to recover data:

Table of Recover Commands
The recover  program provides an interface that allows you to browse files
and control recovers.  When you enter the recover  command, the Backup
prompt appears.

# save -s server pathname

# recover -s server -c client pathname



74 Solstice Backup 4.2 User’s Guide—April 1996

B

The following table provides recover  program commands to enter at the
Backup prompt.

Command Description

add filename add filename to the recover list

cd dir change directory to dir

changetime change the browse time of online index

delete filename delete filename from the recover list

dest verify destination directory for recovered files

force overwrite existing files

help or ‘?’ display list of recover program commands

list list the files in the recover list

ls -f (or lf) filename list filename with file type information

ls - l (or ll) filename list filename using long format

ls filename list filename

noforce do not overwrite existing files

nsrwatch monitor Backup server activity

pwd display name of current directory

quit exit the recover program

recover start the recover program when entered at the system
prompt; start the recovery when entered at the
recover> prompt

relocate dir specify new directory location for recovered files

verbose toggle verbose or quiet mode for recover status
messages

versions filename display backup history of filename
filename can be either a file or a directory

volumes filename list volumes needed to recover marked files
filename can be either a file or a directory
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Your system administrator is responsible for setting up your system to meet
the requirements for Backup clients.

The following conditions must be met for a workstation to qualify as a Backup
client:

• The Backup software is installed.  For installation instructions, see the
Solstice Backup 4.2 Installation and Maintenance Guide.

• The daemon nsrexecd  is running on a Backup client.  The daemon
nsrexecd  is used by savegrp  to start saves on Backup client machines.  To
enable nsrexecd , the install script nsr_ize  must be run on the client.

• The Backup server is configured to recognize the client.  For directions on
how to set up a client, see the Solstice Backup 4.2 Administration Guide.

If any one of the above conditions are not met, you will be unable to use
Backup.  Contact your system administrator before proceeding.
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Glossary

This glossary contains terms and definitions found in this manual.  Most of the
terms are specific to the Solstice Backup for Solaris product.

archiving
A snapshot of a file or directory as it currently exists.  An unlimited expiration
date allows for long-term storage and retrieval.

archive volume
Any type of storage media to which your server can archive data for
long-term storage.  For example, magnetic tape and optical disk.

autochanger
A robotic device with the ability to automatically move, load, and store a
collection of volumes.  This device allows Backup to use the volumes needed
for backups and recovers without operator intervention.

backup
A copy of your workstation data stored on tape or optical disk.

Backup client
A system on your network that backs up and recovers data using Backup.

backup device
The device attached to the Backup server for backing up and recovering data.
For example:  8mm and 4mm tape drives, optical drives, and autochangers.
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Backup server
A system with a backup device that backs up systems configured as Backup
clients across the network.  The server backs up the systems according to a
schedule set by the system administrator.  The server maintains an index of all
the backed-up data and the volumes the backed-up data is stored on.

backup volume
Any type of storage media to which your server can back up.  For example,
magnetic tape and optical disk.

browse time
Viewing specification for files backed up at a specific time.  For example, a
browse time of 09/13/95 24:00 yields a view of files backed up at midnight on
9/13/95 and before.

cloning
Making a duplicate copy of a file or volume.

collapse
Changing the display to show only the parent of a directory in the Backup,
Recover, and Archive windows.

expand
Changing the view to display all levels of a directory in the Backup, Recover,
and Archive windows.

file index
A database on the Backup server containing an entry for every backed-up file.

media index
A database on the Backup server containing entries for all the volumes backed
up and archived by the Backup server.

recover
Replace a lost or damaged file from a copy stored on a Backup backup volume.

save set
A set of files backed up or archived by Backup on a backup or archive volume.

selection
The name of the volume, directory, or file highlighted in a Backup window.

tree structure
A display of files in the Backup, Recover, and Archive windows in hierarchical
format.
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volume
A unit of media used for backup, such as a magnetic tape or an optical disk.

volume pool
A feature that sorts your backup and archive data to selected volumes.  A
volume pool contains a collection of files sorted during the save process by
criteria set by the system administrator.
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add recover command, 74
Annotation field, 60
Archive completion time, 63
Archive options

Clone, 61
Compress, 61
Groom, 61
Verify, 61

Archive Options  dialog box, 60
Archive Pool field, 61
Archive start time, 63
Archive Status dialog box, 61, 63
Archive Title field, 60
archive volumes, 2, 57
Archives list, 64, 67

B
backup

completion time, 19, 40
excluding files, 17
history, 44
marking and unmarking files, 13
starting, 37

Backup Archive window, 59
Backup Backup window, 7

Backup client
changing, 43
defined, 2
update, 43

Backup Options dialog box, 18, 37
Backup Recover window, 20, 41
Backup Retrieve window, 64
Backup server

changing, 36
defined, 2
update, 36

Backup start time, 40
Backup Status dialog box, 19, 40
Backup time details, 32
backup volume, locating, 44
block device icons, 12
browse time, 46
Browse Time command, 46, 47
Browse Time field, 46, 47, 70
browsing

changing time, 47
file index, 20
filesystem, 13
index, 21
selecting level of, 28

button
Archive, 61
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More, 45
Next, 47
Previous, 47
Query, 64
Today, 47
Update Server List, 36

C
calendar for Change Browse Time, 47
canceling

a backup, 40
a recover, 24, 54
a retrieve, 68
an archive, 61

cd recover command, 74
Change Browse Time dialog box, 47
Change Client dialog box, 43
Change pull-down menu, 36, 46
Change Server command, 36, 60
Change Server dialog box, 36
Change Server speedbar button, 36
changetime recover command, 74
changing a selection, 32
changing the Backup server, 36
changing the browse time, 46, 47
character device icons, 12
check box

marking and unmarking files, 29
selecting, 15
versions, 45

choosing a recover client, 42
choosing a recover server, 42
Client pull-down menu, 43
clock icon, 12
closing a window, 13
Collapse Branch command, 29
command

Browse Time, 46, 47
Change Server, 36, 60
Collapse Branch, 29
Exit, 13
Expand Branch, 28

Expand One Level, 15, 28
File Details, 31, 45
Mark, 16
nsr_ize, 75
nsrexecd, 75
nwarchive, 59
nwbackup, 6
nwrecover, 6
nwretrieve, 64
On Topic, 8
Relocate, 50
save, 69
Search, 30, 71
Show Marked, 48
Start Archive, 60
Start Backup, 37
Start Recover, 22, 42
Start Retrieve, 66
Unmark, 17
Volumes, 49

compressing files, 18, 38
Conflict Resolution dialog box, 22, 51
current directory, 32

D
delete recover command, 74
deleting archived files, 57
dest recover command, 74
dialog box

Archive Options, 60
Archive Status, 61, 63
Backup Options, 18, 37
Backup Status, 19, 40
Change Browse Time, 47
Change Client, 43
Change Server, 36
Conflict Resolution, 22, 51
Filename Conflict, 52
Files Marked for Recovery, 49
Recover Status, 24, 53
Recover Volumes Required, 50
Relocate, 71
Retrieve Details, 65
Retrieve Status, 67
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Search, 30, 71
Topics Help, 8
Versions, 44, 45, 46

display
directory, 11
file, 11

E
error messages

backup, 69
backup and recover, 71
invoking Backup, 6
recover, 70

excluding patterns, 18
Exit command, 13
exiting from a window, 13
Expand Branch command, 28
Expand One Level command, 15, 21, 28
expanding directories, 15

F
field

Annotation, 60
Archive Pool, 61
Archive Title, 60
Browse Time, 46, 47, 70
Pattern, 39
Relocate to, 67
Search annotation for, 65
Selection, 11, 32, 72
Server, 36
Status, 68

file compression choices, 38
File Details command, 31, 45
file display, 11
file index entries, 21
File pull-down menu, 13
Filename Conflict dialog box, 52
files

compressing, 18
marking and unmarking, 29
recovering deleted, 46

searching for, 30
viewing past versions of, 46

Files Marked for Recovery dialog box, 49
filesystem, space for recover, 70
folder icons, 12
force recover command, 74

H
Help pull-down menu, 8
help recover command, 74
highlighted folder icon, 12

I
icons

graphical, 12
NW Archive, 58
NW Backup, 5
NW Recover, 5
NW Retrieve, 64

index, 19

L
list

Archives, 64, 67
Operations, 61

list recover command, 74
listing recover volumes, 49
ls -F recover command, 74
ls -l recover command, 74
ls recover command, 74

M
Mark command, 16
Mark pull-down menu, 48
Mark speedbar button, 29
marking

directories, 15, 29
files, 13, 29
files for recovery, 20
subdirectories, 16
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menu bar, 7
monitoring

a backup, 19, 40
a recover, 24, 53
a retrieve, 68
an archive, 63

More button, 45
mount point icons, 12

N
naming conflict, defined, 23
noforce recover command, 74
nsr_ize command, 75
nsrexecd command, 75
nsrwatch recover command, 74
NW Archive icon, 58
NW Backup icon, 5
NW Recover icon, 5
NW Retrieve icon, 64
nwarchive command, 59
nwbackup command, 6
nwrecover command, 6
nwretrieve command, 57, 64

O
On Topic help command, 8
Operations list, 61
Options pull-down menu, 50
overwriting existing files, 67

P
Pattern field, 39
patterns

changing and deleting, 39
excluding from a backup, 38, 39

pull-down menus
Change, 36, 46
Client, 43
File, 13
Help, 8

how to use, 7
Mark, 48
Options, 50
Server, 42
Tree, 28
View, 30, 44, 49

pwd recover command, 74

Q
Query  button, 64
Quick Tour

review, 25
starting point, 13

quit recover command, 74

R
recover

command table, 73
files, deleted, 46
preparing to, 41
volumes needed, 24, 49

recover command, 74
Recover Status dialog box, 24, 53
Recover Volumes Required dialog box, 50
reducing Backup traffic, 18, 38
Relocate command, 50
Relocate dialog box, 71
relocate recover command, 74
Relocate to field, 67
renaming or overwriting recovered

files, 51
Retrieve Details dialog box, 65
Retrieve Status  dialog box, 67

S
scrollbar, 11
Search annotation for field, 65
Search command, 30, 71
Search dialog box, 30, 71
Search speedbar button, 30
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searching for files, 30
selecting

archive volume pool, 61
clone volume pool, 62
versions of directories, 46
versions of files, 44, 45

Selection field, 11, 32, 72
Server field, 36
Server pull-down menu, 42
sheet icons, 12
Show Marked command, 48
speedbar buttons

Change Server, 36
Mark, 29
Search, 30
Start, 37
Unmark, 29

Start Archive command, 60
Start Backup command, 37
Start Recover command, 22, 42
Start Retrieve command, 66
Start speedbar button, 37
starting Backup

Archive, 58
Backup, 6
pathname of directory, 6, 14
Recover, 6
Retrieve, 64

Status field, 68
symbolic link icons, 12

T
Topics Help dialog box, 8
Tree pull-down menu, 28
tree structure, 21, 28

U
UNIX

shell pattern characters, 30, 39
shell tool, 24

Unmark command, 17

Unmark speedbar button, 29
unmarking files, 17, 29
Update Server List button, 36

V
valid browse time formats, 47, 70
verbose recover command, 74
Versions dialog box, 44, 45, 46
versions recover command, 74
View pull-down menu, 30, 44, 49
viewing

backup times, 32
directories, 28
file details, 32
files in the past, 46
selecting detail, level of, 30

Volumes command, 49
volumes recover command, 74

W
windows

Backup Archive, 59
Backup Backup, 7
Backup Recover, 20, 41
Backup Retrieve, 64
controls, 11
using, 6
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